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NEW QUESTION 1
- (Topic 3)

Which path would you take to access the table configuration page from a form?

A. The Form Context menu > View > Table
B. The Form Context menu > Configure > Table
C. The Form Context menu > Configure > Dictionary
D. The Form Context menu > View > Show Table

Answer: B

NEW QUESTION 2
- (Topic 3)
In Flow Designer, where is the data from an action stored so it can be used in subsequent actions in the flow?

A. Field Icon
B. Field Value
C. Data Pill
D. Data Element
E. Data Trigger

Answer: D

NEW QUESTION 3
- (Topic 3)
While testing a Catalog Item for ordering an expensive computer, the mandatory approval is being skipped for requester Bob, Smith, but not for any of the other
requesters. What could explain the issue?

A. There is a business rule, excluding Bob.Smith from any approvals.
B. Bob Smith does not have a delegate set up on his account,
C. The Bob Smith user account, does not have a manager specified.
D. The manager does not have a delegate assigned,
E. Bob Smith is a VIP.

Answer: A

NEW QUESTION 4
- (Topic 3)
While showing a customer their incident form, they ask to change the Priority field title to display their internal terminology PValue. How would you do that? Choose
2 answers

A. Right click on Priority and select Configure Dictionary
B. Right click on Priority and select Configure Display Settings
C. Right click on Priority and select Configure Label
D. Right click on Priority and select Configure Column
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Answer: AC

NEW QUESTION 5
- (Topic 3)
An administrator creates "customer_table_admin" and "customer_table_user" roles for the newly created "Customer Table". Which ACL rule would grant access to
all rows and all fields to both the customer_table_admin and customer_table_user roles?

A. customer.all
B. customer .*
C. customer.field
D. customer.none

Answer: B

Explanation: 
The customer .* ACL rule would grant access to all rows and all fields to both the customer_table_admin and customer_table_user roles because it uses a
wildcard (*) to match any operation on the customer table. The other options are either too restrictive or too broad.
References1: Access control list rules - Product Documentation: Utah - ServiceNow4: Access Controls — ServiceNow Elite

NEW QUESTION 6
- (Topic 3)
From a related list, what would a user click for personalize the layout of the columns?

A. Magnifier
B. Context Menu
C. Pencil
D. Gear

Answer: D

NEW QUESTION 7
- (Topic 3)
On the Form header, which icon do you use to access form templates?

A. Paperclip
B. Pages
C. Stamp
D. More Options {...)

Answer: D

NEW QUESTION 8
- (Topic 3)
Which type of scripts nun in the browser?

A. Script include Scripts
B. Business Rule Scripts
C. Access Contra! Scripts
D. Ul Policies and Client Scripts

Answer: D

NEW QUESTION 9
- (Topic 3)
What are advantages of using Flow Designer? (Choose three.)

A. Supports advanced developers
B. Enables complicated scripting
C. Reduces technical debt
D. Less manual scripting
E. Smooth integration with 3rd party systems

Answer: CDE

NEW QUESTION 10
- (Topic 3)
A colleague wants to rearrange the columns on their My Work list. Once the user has navigated to the list where should they navigate to select and arrange the
columns?

A. Click Personalize List
B. Right click on any column heade
C. Context Menu > Configure > List Layout
D. Click List Context Menu > Personalize List
E. Click List Content Menu > Configure > List Layout

Answer: B
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Explanation: 
 To rearrange the columns on a list, users can right click on any column header and select Configure > List Layout from the context menu2. This will open a dialog
box where users can select the available fields and move them to the selected list using the arrow buttons2. Users can also drag and drop the fields to change the
order of the columns2.
References
? How To Configure List and Form Layouts | by ServiceNow Scholar - Medium2

NEW QUESTION 10
- (Topic 3)
What section on a task record is used to see the most recent updates made to a record?

A. Related List
B. Activity Stream
C. Audit Log
D. Timeline

Answer: B

NEW QUESTION 11
- (Topic 3)
Which tool graphically displays an infrastructure view for a configuration item (CI) and its relationship with other CIs?

A. Schema Map
B. Dependency View
C. Dependency Map
D. Database View

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/business-service-management-map-
ng/concept/c_BusinesssServiceManagementMaps.html

NEW QUESTION 13
- (Topic 3)
The customer has asked that your change the default layout of the task list.
* Number
* Task Type
* Parent
* Short Description
* Assignment Group
* Assignment
* Updated
After navigation to the list, where would you click, to meet this requirement?

A. Right click on any column header, Context menu > Configure > List Layout
B. Right click List Gear icon > Configure > Columns
C. Click List Context Menu >Personalize List
D. Click List Context Menu > Configure Columns

Answer: B

NEW QUESTION 18
- (Topic 3)
The Report Designer contains different section for configuring your report. Which section is used to specify the name of the report, and the table or data source for
the report.

A. Properties
B. Data
C. Configure
D. Type
E. Sources

Answer: C

NEW QUESTION 19
- (Topic 3)
When using the Data Pill Picker, use which keys to dot-walk (6 fields in other tables?

A. Arrows
B. Plus, Minus
C. Ctrl c, Ctrl
D. Ctrl <, Ctrl >
E. Shift F4, Shit FS

Answer: A
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NEW QUESTION 22
- (Topic 3)
On what part of the ServiceNow instance, would you find the option to access applications, like Incident Management?

A. Self Service Module
B. Application Navigator
C. Service Desk Homepage
D. Favorites

Answer: B

NEW QUESTION 26
- (Topic 3)
Here is an example of the criteria set for a knowledge base:
* Companies: ACME North America
* Department: HR
* Groups: ACME Manager
* Match All: Yes
In this example, what users would have access to this knowledge base?

A. Members of the ACME manager group, who are also members of HR Department and part of the ACME North America
B. Employees of ACME North America, who are members of HR Department or the ACME Manager group
C. Users which are members of either ACME North America, or HR Department, or ACME Manager Group
D. Member of the ACME Manager group, and HR department, regardless of geography

Answer: A

NEW QUESTION 30
- (Topic 3)
On the Cl Dependency View, what enables you to trace from an infrastructure item, like a Server, to the Services that are dependent on that Server?

A. Service Tracer
B. Automapping Utility
C. Relationships
D. Transform Map

Answer: C

NEW QUESTION 34
- (Topic 3)
A manager wants to view a snapshot of month-end Sales performance data, as compared to Sales targets. In addition, the manager wants to be able to see those
monthly numbers trended over time, and
forecasted into the future. What capability do you suggest for this manager?

A. Scheduled Reports, a custom snapshot table, and a Trend report
B. Scheduled Reports and Excel
C. Scheduled Reports, a custom snapshot table, and a Projection report
D. Performance Analytics
E. Key Performance Indicators

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-now-intelligence/page/use/performance-analytics/concept/c_ForecastingData.html

NEW QUESTION 39
- (Topic 3)
Which modules can you use to create a new table? Choose 2 answers

A. Tables & Columns
B. Schema Map
C. Dictionary
D. Tables

Answer: AD

NEW QUESTION 44
- (Topic 3)
Which feature ensures data consistency white importing data using import sets and web services?

A. Client Script
B. Ul Policy
C. Data Policy
D. CSDM
E. Business Rule

Answer: C

Passing Certification Exams Made Easy visit - https://www.surepassexam.com



Recommend!! Get the Full CSA dumps in VCE and PDF From SurePassExam
https://www.surepassexam.com/CSA-exam-dumps.html (371 New Questions)

Explanation: 
 Data policies are used to define rules that govern the creation, modification, and deletion of data in ServiceNow. These policies can be used to ensure data
consistency by enforcing data quality standards and preventing invalid or inaccurate data from being imported.
References:
? ServiceNow Product Documentation: Data policies overview - https://docs.servicenow.com/bundle/vancouver-platform-
administration/page/administer/field-administration/concept/c_DataPolicy.html

NEW QUESTION 49
- (Topic 3)
Which framework can automatically populate values for the priority and Category field based on the Short description field value?

A. UI Policy
B. Assignment Rule
C. Action
D. Predictive intelligence
E. CSDM

Answer: A

NEW QUESTION 52
- (Topic 3)
When importing data from a spreadsheet, which step defines where the incoming data columns will be written in the receiving table?

A. Field Matching
B. Load Data
C. Select Data Source
D. Schedule Transform
E. Create Transform Map

Answer: E

Explanation: 
 A transform map is a set of field maps that define the relationships between fields in an import set and fields in an existing table1. When importing data from a
spreadsheet, creating a transform map is the step that defines where the incoming data columns will be written in the receiving table2. The transform map allows
users to specify how to transform the source data into the target data, such as by using scripts, coalescing, or mapping assist1.
References
? Transform Maps - Product Documentation: San Diego - ServiceNow1
? Importing Data: Excel to ServiceNow - Finite Partners2

NEW QUESTION 57
- (Topic 3)
On Access Control Definitions, what are ways you can set the permissions on a Table? Choose 3 answers

A. Groups
B. CRUD
C. Roles
D. Script that sets the answer variable to true or false
E. Conditional Expressions

Answer: CDE

NEW QUESTION 60
- (Topic 3)
Your customer requires that they be able to monitor which users are performing impersonations in their instance. What would you do to meet that requirement?

A. Add the role Log Write [sn_log_write] to the Impersonator Group
B. Create user update set for impersonation tracking
C. Activate the glide.sys.log_impersonation prop
D. From User icon, select Elevate Roles
E. On the Impersonator role record, right click and select Create Log

Answer: C

Explanation: 
 Reference https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0717055

NEW QUESTION 65
- (Topic 3)
On a Business Rule, the When salting determines at what point the rule executes. What are the options for specifying that timing?

A. Insert, Update, Delet
B. Query
C. 4G} Before, After, Async, Display
D. Prior to, Synchronous, on Update
E. Before, Synchronous, Scheduled Job, View

Answer: B
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NEW QUESTION 67
- (Topic 3)
Tables may be set up with Many to Many relationships. What is a classic example of a scenario where the tables would have many to many relationships?

A. Requests can contain many items; and Items can be any item from the catalog.
B. Vendors can sell multiple products; and products can be sold by multiple vendors.
C. A Task can trigger many Workflows; and a Workflow can trigger many Tasks
D. A Configuration Item can belong to multiple Classes; and Classes can contain multiple Configuration Items.

Answer: B

NEW QUESTION 68
- (Topic 3)
What capability allows users to create dashboards with widgets to visualize data over time in order to identify areas of improvement?

A. Analytics Reports
B. Performance Analytics
C. Scheduled Reports
D. Reporting

Answer: B

NEW QUESTION 71
- (Topic 3)
What action will allow you to personalize layouts of columns in a list?

A. Click Gear icon > Personalize window options > Select the appropriate columns
B. Select the column to be personalized > Click Edit icon (Penal) > Choose me options to personage
C. Context Menu > View > Personalize
D. Select the column to be personalized and right at the header > Choose the options to personalize

Answer: A

NEW QUESTION 74
- (Topic 3)
When adding a related list to a form, you choose the related list from the list callector, What is an example of a related list you might see on the list collector?
Choose 3 answers:

A. Release Phase==Parent
B. Catalog Task->Parent
C. HR Case-=Parent
D. Problem==Parent
E. Outage->Task number

Answer: BCE

NEW QUESTION 79
- (Topic 3)
Which statement correctly describes the differences between a Client Script and a Business Rule?

A. A Client Script executes before a record is loaded and a Business Rule executes after a record is loaded
B. A Client Script executes on the server and a Business Rule executes on the client
C. A Client Script executes on the client and a Business Rule executes on the server
D. A Client Script executes before a record is loaded and a Business Rule executes after a record is updated

Answer: C

Explanation: 
Reference: https://community.servicenow.com/community?id=community_question&sys_id=77a80361
db5cdbc01dcaf3231f9619d9#:~:text=The%20major%20difference%20between%20of,delet
ed%2Fqueried%20from%20data%20base.&text=After%20that%2C%20the%20Client%20s cripts,Client%20scripts%20that%20work%20onSubmit

NEW QUESTION 83
- (Topic 3)
What is the result of the order in which access controls are evaluated?

A. Ensures user has access to the fields in a table, before considering their access to the table
B. Ensures user can get to work as quickly as possible
C. Ensures user has access to the application, before evaluating access to a module within the application
D. Ensures user has access to a table, before evaluating access to a field in the table

Answer: D

Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0541355
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NEW QUESTION 86
- (Topic 3)
Which low components allow you to specify when a flow should be run?

A. Trigger and Condition Pill
B. Scope and Trigger Condition
C. Trigger and Condition
D. Trigger Criteria and Clock
E. Condition and Table

Answer: C

Explanation: 
 Triggers define when a flow should start running, and conditions are used to specify the specific circumstances under which a flow should run. By combining
triggers and conditions, you can create flows that run only when specific events occur and only for certain types of records.
References:
? ServiceNow Product Documentation: Flow Designer - Overview - https://docs.servicenow.com/bundle/sandiego-application-development/page/administer/flow-
designer/concept/flow-designer.html
? ServiceNow Product Documentation: Flow triggers - https://docs.servicenow.com/bundle/tokyo-application-development/page/administer/flow-
designer/reference/flow-triggers.html

NEW QUESTION 90
- (Topic 3)
Which feature enables business process owners to organize Flow Designer content into unified and digitized cross-enterprise processes via a digitized task board
Interface?

A. Flow Designer
B. Process Automation Designer
C. Process Workflow Designer
D. Workflow Editor

Answer: B

NEW QUESTION 92
- (Topic 3)
Which tables are children of the Task table and come with the base system? Choose 3 answers

A. Incident
B. Problem
C. Change Request
D. Config
E. Dictionary
F. cmdb

Answer: ABC

Explanation: 
 The Task table is a base table in ServiceNow, which means it is not extended from any other table. However, other tables can extend the Task table to inherit its
fields and functionalities. Incident, Problem, and Change Request are all child tables of the Task table, meaning they inherit the fields and functionalities of the
Task table and add their own specific fields and functionalities.
References
? https://docs.servicenow.com/bundle/vancouver-platform-administration/page/administer/task-table/concept/c_TaskTable.html
? https://www.servicenow.com/community/now-platform-forum/parent-table-to-get-an-access-to-child-table-column/m-p/1133982
? https://www.servicenow.com/community/developer-forum/difference-between-a-base-class-and-base-table/m-p/1618247

NEW QUESTION 94
- (Topic 3)
What Service Catalog feature do you use to organize items into logical groups?

A. Variable sets
B. Catalog items
C. Sections
D. Categories

Answer: A

NEW QUESTION 95
- (Topic 3)
What access does a user need to be able to import articles to a knowledge base?

A. sn_knowledge_import
B. sn_knowledge contribute
C. Can contribute
D. Can import

Answer: C

NEW QUESTION 100
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- (Topic 3)
The Employee On-boarding team has asked for a way for managers to order computers, monitors, business Cards, and cell phones for new employees. How
would you proceed to meet this requirement?

A. Create Record Producer
B. Create Order Guide
C. Create Requested Item
D. Create On-boarding Bot

Answer: B

NEW QUESTION 102
- (Topic 3)
An IT user calls the service desk because they need to work on task records. All they can see is Self Service on their homepage when they login to the
ServiceNow instance. What issue could explain this? Choose 2 answers

A. Their user account failed LDAP authentication
B. Their user account is not logged in properly
C. Their user account was not approved by their manager
D. Their user account does not have itil role
E. Their user account does not belong to any groups, which contain the itil role

Answer: AC

NEW QUESTION 105
- (Topic 3)
What are advantages of using spokes for integrations? Choose 3 answers

A. Reduces the need for code
B. Features scale and control mechanisms
C. Free spokes are available in the ServiceNow Store
D. Ensures discoverability and reuse
E. Automated event management

Answer: ADE

NEW QUESTION 110
- (Topic 3)
Which type of scripts run in the browser?

A. Policies and Client Scripts
B. Access Contral Scripts
C. script Include Scripts
D. Business Rule Scripts

Answer: A

NEW QUESTION 113
- (Topic 3)
Which SericeNow utility gives a Service Desk agent the ability to trace from a Service having an issue, to see which Cis supporing that service have active issues?

A. AL Service Dashboard
B. Cl Health Dashboard
C. Dependency View
D. Event Management Homepage

Answer: B

NEW QUESTION 116
- (Topic 3)
What is the best practice related to using the Default Update Set for moving customizations between instances?

A. Merge Default update sets before moving between instances
B. Submit Default update set to application repository
C. You should not use the Default Update sets for moving between instances
D. Keep Default update set to maximum of 20 records, for troubleshooting purposes

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-sets/reference/default-update-sets.html

NEW QUESTION 117
- (Topic 3)
ServiceNow contains over 25 different report types. What are some of the types? Choose 5 answers

A. Pie

Passing Certification Exams Made Easy visit - https://www.surepassexam.com



Recommend!! Get the Full CSA dumps in VCE and PDF From SurePassExam
https://www.surepassexam.com/CSA-exam-dumps.html (371 New Questions)

B. Speedometer
C. Odometer
D. Thermometer
E. Horizontal Bar
F. Semi-Donut
G. Donut

Answer: ABEFG

NEW QUESTION 122
- (Topic 3)
When an administrator sets a policy that is applied to all data entered into the Platform (UI, Import Sets, or Web Services), where does this policy run by default?

A. Network
B. Server
C. Client
D. Browser

Answer: B

Explanation: 
 A policy that is applied to all data entered into the Platform is called a Data Policy. Data policies run on the server side and enforce data consistency by setting
mandatory and read-only states for fields1.
ReferencesData policies

NEW QUESTION 124
- (Topic 3)
What are the steps for importing data using an import set?

A. Select source file; Run automap; Transform data; Clean up target table
B. Set up LDAP; Test map: Create update set; Run import: Apply update set
C. Identify source; Import transform map: Run transformer; Verity import
D. Load the data; Create transform map; Transform data; Clean up import table

Answer: D

NEW QUESTION 126
- (Topic 3)
After you create a new table, what is the best practice regarding the navigation pane? Choose 2 answers

A. Set the filter condition on the Application Menu
B. Set the font style on both the Application Menu and the Module
C. Specify which Roles are able ta see the Module
D. Specify which Roles are able to see the Application Menu
E. Create Application Menu with the same name as the table label
F. Create Module with the plural of the table label

Answer: CD

NEW QUESTION 128
- (Topic 3)
You are looking at a list of Active incidents. You want to exclude incidents with the state of Resolved. How might you do that?

A. On the list of records, locate the right-click on the Resolved value, select Exclude.
B. Click Funnel icon, click AND, Select Resolved, is Not State click Run
C. On state column title, right-click, select Filter Out > Resolved
D. On Search, select State, type not Resolved, press enter
E. On the list of records, locate and right-click on the Resolved value, select Filter Out

Answer: E

NEW QUESTION 132
- (Topic 3)
Which ServiceNow utility provides a modern interactive graphical interface to visualize
configuration items and their relationship?

A. CSDM Schema
B. Business Service Map
C. Dependency View
D. CI Class Map

Answer: D

NEW QUESTION 133
- (Topic 3)
A customer requests the following data quality measures be added:
* 1. Incident numbers should be read-only on all lists and forms, for all users.
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* 2. Short Description field should be mandatory, on all records, across all applications, on insert.
Which type of policy would you use to meet this requirement?

A. Data policy
B. Dictionary Design Policy
C. Data Quality Policy
D. Field Criteria Policy

Answer: A

NEW QUESTION 137
- (Topic 3)
What is the most common role that has access to almost all platform features, functions, and data?

A. Security Admin [security_admin]
B. Sys Admin [sys_admin]
C. Admin [sn_admin]
D. System Administrator [admin]
E. Base Admin [base_admin]

Answer: C

Explanation: 
Reference: https://developer.servicenow.com/dev.do#!/guides/quebec/now-platform/glossary/developer-glossary

NEW QUESTION 140
- (Topic 3)
Access controls are evaluated in this order:
* 1. Match object against table ACL
* 2, Match the object against field ACL
Within step 1 above, what order are the table ACLs evaluated?

A. Specific to general: Table.Field ACL, Parent Table.Field ACL, *.Field ACL
B. Bottom to top: Table AC
C. Table.Field ACL, Parent Tabl
D. Field ACL
E. General to specific: Table ACL, Table.Field ACL, Parent Table, Field ACL
F. Top to bottom: Wildcard Table ACL, Parent Table ACL, Table ACL
G. Specific general: Table ACL, Parent Table ACL, Wildcard (*) ACL

Answer: E

NEW QUESTION 145
- (Topic 3)
Which data consistency settings can be achieved using UI Policy? Choose 3 answers

A. Setting fields to accept the data with ‘n’ number of characters
B. Setting fields hidden
C. Setting fields to accept the data in an expected format
D. Settings fields read-only
E. Setting fields mandatory

Answer: BDE

NEW QUESTION 150
- (Topic 3)
What is used to determine user access to knowledge bases or a knowledge article?

A. sn_kb_read, sn_article_read
B. Privacy Settings
C. Read Access Flag
D. User Criteria

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/concept/user-access-knowledge.html

NEW QUESTION 155
- (Topic 3)
Which tab on the knowledge base record, would you use to identify the sets of users who are able to read articles in that knowledge base?

A. Access List
B. Can Access
C. Accessible to
D. Can Read

Answer: D
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Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/task/t_SelectUserCriteria.html

NEW QUESTION 157
- (Topic 2)
On a Form header, what is the three bar icon called?

A. Pancake icon
B. Additional Actions or Context Menu
C. Hamburger icon
D. Cake icon

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-forms/concept/c_FormContextMenu.html

NEW QUESTION 159
- (Topic 2)
On the Reports page, what sections allow you to see which reports are visible to different audiences? (Choose four.)

A. Group
B. Department
C. My reports
D. Team
E. Dashboards
F. Global
G. Admin
H. Analytics
I. All
J. Company

Answer: AEFG

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-now-intelligence/page/use/reporting/task/t_ShareASetting.html

NEW QUESTION 163
- (Topic 2)
When creating a global custom table named “abc”, what is the table name that is automatically assigned by the platform?

A. snc_abc
B. abc
C. u_abc
D. sys_abc

Answer: C

NEW QUESTION 168
- (Topic 2)
Which one of the following is NOT a type of Visual Task Board?

A. Feature
B. Guided boards
C. Flexible
D. Freeform

Answer: A

Explanation: 
https://docs.servicenow.com/bundle/london-servicenow-platform/page/use/visual-task-boards/reference/r_BoardStructure.html

NEW QUESTION 172
- (Topic 2)
ServiceNow contains a resource which provides the following:
A standard and shared set of service related definitions across ServiceNow products and platform that will enable and support true service level reporting.
A CMDB framework across our products and platform that will enable and support multiple configuration strategies.
What resource do these statements describe?

A. Common Services Data Model (CSDM)
B. Information Technology Service Management (ITSM)
C. Configuration Management Database (CMDB)
D. Information Technology Infrastructure Library (ITIL)

Answer: A

Explanation: 
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Reference: https://www.servicenow.com/content/dam/servicenow-assets/public/en-us/doc-type/resource-center/solution-brief/sbr-servicenow-common-service-data-
model.pdf

NEW QUESTION 175
- (Topic 2)
Which of the following is used to categorize, flag, and locate records?

A. Search
B. Favorites
C. Tags
D. Bookmarks

Answer: C

NEW QUESTION 176
- (Topic 2)
Two departments (HR Onboarding and Facilities) have come to you, asking for a way for employees to request event room set up services. The requirements are
the same for the form and the task routing to the Facilities’ assignment group.
For HR, the item will be used primarily for the Onboarding coordinators, for employee orientation sessions.
For Facilities, the item will be used for anyone in the company who needs room set up services.
However, both departments have their own service catalogs. What do you do, to support these requirements?

A. Create one Catalog Item for HR Event Room Set Up and one for Facilities Event Room Set Up; then publish each to the appropriate Catalog.
B. Create one Catalog Item for Event Room Set Up; then publish to both Catalogs.
C. Create one Catalog Item for Event Room Set Up; then publish to the Parent Catalog, which is accessible to both HR and Facilities.
D. Create one Catalog Item for Event Room Set Up; then use ACLs to control access.

Answer: C

NEW QUESTION 177
- (Topic 2)
From a form, what would you click to add additional fields to the form? (Choose two.)

A. Context Menu > Form > Layout
B. Context Menu > Configure > Form Layout
C. Context Menu > Configure > Form Design
D. Right click on header > Add > Field
E. Context Menu > Form > Designer
F. Right click on header > Configure > UX Dashboard

Answer: BD

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-it-service-management/page/product/change-management/task/t_CreateCustomField.html

NEW QUESTION 181
- (Topic 2)
Which core table in the ServiceNow platform provides a series of standard fields used on each of the tables that extend it, such as the Incident [incident] and
Problem [problem] tables?

A. Task [task]
B. Assignment [assignment]
C. Service [service]
D. Workflow [workflow]

Answer: A

NEW QUESTION 185
- (Topic 2)
What is a key difference between Reporting and Performance Analytics?

A. Performance Analytics contains snapshots of data taken over time; Reporting shows only the data as it is, at the moment the report is run.
B. Performance Analytics can show trends; Reports cannot.
C. Reports can be run on a scheduled basis; Performance Analytics cannot.
D. Performance Analytics data can be published to Dashboards; Reports cannot.
E. Performance Analytics shows KPIs; Reporting does not.

Answer: B

NEW QUESTION 188
- (Topic 2)
What is an Event in ServiceNow?

A. An Event is a trigger that has a direct response in the platform
B. An Event is an indication to the ServiceNow processes that something has occurred
C. An Event is an indicator that a Priority 1 (P1) Incident has been logged
D. An Event is a recognized, scheduled occurrence of a process
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Answer: B

NEW QUESTION 192
- (Topic 2)
When testing a catalog item, having a manager approval flows, which of these best practices would you follow? (Choose three.)

A. Make sure the latest flows are activated.
B. Use the instance Incognito setting to quickly toggle between requester and approver.
C. Impersonate the requester to ensure the form works.
D. Make sure the requester's user record has a manager specified.
E. Create and select your Testing Update Set, before starting the test cases.
F. Use your Admin account, so you can approve the items quickly.

Answer: DEF

NEW QUESTION 196
- (Topic 2)
What are the three permission requirements that must evaluate to true for an access control rule to apply?
Choose 3 answers

A. Conditions
B. table.
C. Roles
D. Script
E. table."
F. table.none

Answer: CDE

NEW QUESTION 197
- (Topic 2)
While showing a customer their incident form, they ask to change the Priority values to display their internal terminology P1, P2, P3, P4. They want it to be
consistent across all Tasks. How would you do that?
Right click on Priority and select what?

A. Configure Lists
B. Show Options
C. Configure Task
D. Show Choices
E. Show Choice List
F. Configure Options

Answer: F

NEW QUESTION 202
- (Topic 2)
How is a group defined in ServiceNow?

A. A group is one record stored in the Group Type [sys_user_group_type] table
B. A group is one record stored in the Group [sys_user_group] table
C. A group defines a set of users that share the same location
D. A group defines a set of users that share the same job title

Answer: B

NEW QUESTION 205
- (Topic 2)
Which module would you use to create a new automation of business logic such as approvals, tasks, and notifications?

A. Process Automation > Flow Designer
B. Process Automation > Flow Administration
C. Process Automation > Workflow Editor
D. Process Automation > Process Flow
E. Process Automation > Active Flows

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/process-automation-designer/concept/getting-started-process-
automation.html

NEW QUESTION 209
- (Topic 2)
What is the primary application used to load data into ServiceNow?

A. Service Level Management
B. Configuration
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C. System Import Sets
D. System Update Sets

Answer: C

NEW QUESTION 213
- (Topic 2)
New records, new groups, and modified configuration Items (Cls): what do they have in common?

A. They are included in an Update Set
B. They are not captured in an Update Set
C. They are customizations
D. They do not have anything in common

Answer: A

NEW QUESTION 216
- (Topic 2)
When using the Performance Analytics application in the Now Platform, what kind of KPI signals are used to make decisions that statistically support long term
workflow stability?

A. Long-term signals
B. Non-signals
C. Anti-signals
D. Stability signals

Answer: C

NEW QUESTION 217
- (Topic 2)
When does the Submit button appear on a form?

A. When saving an old record
B. When creating a new record
C. When changing the reference field in an existing record
D. When updating an existing record

Answer: B

NEW QUESTION 222
- (Topic 2)
You are showing your customer a new form that you have created for their new application. They would like to add a field to the form. Where could you do that?
(Choose two.)

A. Select Fields and Columns module
B. Right click on form header, select Configure > Form Layout
C. Click on context menu, select Configure > Form Designer
D. Select Field Class Manager module

Answer: BC

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-it-service-management/page/product/change-management/task/t_CreateCustomField.html

NEW QUESTION 225
- (Topic 2)
Which plugin allows users to install multiple applications, application-customizations. or plugins at once?

A. Application Integration and Plugin Delivery (A1PD) SpokeBatch Install
B. Continuous Integration and Continuous Delivery (CICD) SpokeBatch Install
C. Multiple Integration and Process Delivery (MIPD) SpokeBatch Install
D. Quick Integration and Multiple Delivery (QIMD) SpokeBatch Install

Answer: B

NEW QUESTION 227
- (Topic 2)
What type of field allows you to look up values from one other table?

A. Reference
B. Verity
C. Options
D. Selections
E. Dot walk
F. Lookup

Answer: 
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A

Explanation: 
Reference: https://support.microsoft.com/en-us/office/create-or-delete-a-lookup-field-87e84cbd-d60c-4473-8a98-
3e391c42f239#:~:text=A%20lookup%20field%20can%20display,order%20in%20the%20Orders%20table

NEW QUESTION 230
- (Topic 2)
What is specified in an Access Control rule?

A. Groups, Conditional Expressions and Workflows
B. Table Schema, CRUD, and User Authentication
C. Object and Operation being secured; Permissions required to access the object
D. security_admin

Answer: C

Explanation: 
Reference: https://www.servicenowelite.com/blog/2019/10/2/access-controls#:~:text=An%20instance%20uses%20access%20control,object%20and%20operati
on%20being%20secured

NEW QUESTION 233
- (Topic 2)
When impersonating a user for testing purposes, what is the best way to return the instance, logged in with your user account?

A. Turn your computer off and on again
B. Clear browser cache
C. End Impersonation
D. Log out and back in

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/users-and-groups/concept/c_ImpersonateAUser.html

NEW QUESTION 237
- (Topic 2)
What do you call any component that needs to be managed in order to deliver services?

A. CSDM Items
B. CMDB
C. Configuration item
D. Service Offerings
E. Asset

Answer: C

Explanation: 
Reference: https://infocenter.io/servicenow-cmdb-implementation/

NEW QUESTION 239
- (Topic 2)
What is used frequently to move customizations from one instance to another?

A. Update Sets
B. Code Sets
C. Update Packs
D. Configuration Logs
E. Remote Sets
F. Local Sets
G. Code Packs

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-it-operations-management/page/product/service-mapping/task/export-patterns.html

NEW QUESTION 242
- (Topic 2)
What would NOT appear in the Application Navigator if “service” is typed into the filter field?

A. Configuration > Business Services
B. Self-Service > Knowledge
C. Service Portal > Widgets
D. Incident > Assigned to me

Answer: D
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NEW QUESTION 247
- (Topic 2)
When moving multiple update sets at one time, what might you do to facilitate the move?

A. Batch
B. Verify
C. Test
D. Preview

Answer: A

Explanation: 
Reference: https://www.servicenowelite.com/blog/2016/8/7/update-sets

NEW QUESTION 250
- (Topic 2)
What are the components that make up a filter condition? (Choose three.)

A. Operator
B. Match Criteria
C. Value
D. Column
E. Field

Answer: ACE

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_Filters.html

NEW QUESTION 251
- (Topic 2)
What ServiceNow tables can Administrators define as "destinations" for imported data, when using Transform Maps in the System Import Sets application?

A. The Task table is the only table that can be a destination for imported data in the Transform Map module
B. The Inciden
C. Proble
D. Change, Task, and Service Catalog tables are the only tablesthat can be a destination for imported data m the Transform Map module
E. Only the Incident Problem, and Change tables can be a destination for imported data in the Transform Map module
F. Any ServiceNow table can be a destination for imported data in the Transform Map module

Answer: B

NEW QUESTION 254
- (Topic 2)
What controls the publishing and retiring process for knowledge articles?

A. Approval Policies
B. Approval Definitions
C. Workflow Designer
D. Workflows
E. State Lifecycle

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/reference/r_KnowledgeWorkflows.html

NEW QUESTION 256
- (Topic 2)
What icon do you use to change the label on a Favorite?

A. Clock
B. Hamburger
C. Pencil
D. Three dots
E. Triangle.
F. Star

Answer: C

Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0781451

NEW QUESTION 259
- (Topic 2)
What do you need to do before you can use an Application-based trigger in your flow?
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A. Activate application trigger spoke
B. Activate trigger security rules
C. Activate application spoke, and plug-ins as needed
D. Assign Application trigger role [sn_app_trigger_write] to SME
E. Activate application plugins only

Answer: B

NEW QUESTION 261
- (Topic 2)
What is a sys_id?

A. Unique 32-character identifier that is assigned to every record
B. A client-side Business Rule
C. A server-side Business Rule
D. Unique 64-character identifier that is assigned to every record

Answer: A

NEW QUESTION 263
- (Topic 2)
What is the difference between a UI Policy and Data Policy?

A. Data Policies run when data is entered through the form, by an Import Set, or by webservices, while UI Policies are set only by web services
B. Data Policies can be converted into UI Policies, but UI Policies cannot be converted into Data Policies
C. Data Policies run regardless of how data is entered into ServiceNow, while UI Policies are used for form interactions
D. Data Policies run only after UI Policies run successfully

Answer: C

NEW QUESTION 267
- (Topic 2)
The ServiceNow platform includes which types of interfaces? (Choose three.)

A. Now Mobile Apps
B. Agent Control Center
C. Back Office Dashboard
D. Service Portals
E. Now Platform® User Interfaces
F. Field Service Taskboard

Answer: ADE

Explanation: 
 A. https://docs.servicenow.com/bundle/rome-mobile/page/administer/tablet-mobile-ui/concept/mobile-config-navigation.html D and E.
https://www.servicenow.com/products/service-portal.html

NEW QUESTION 270
- (Topic 2)
How are local flow variables accessed in the Flow Designer Data panel?

A. As newly generated icons
B. As scratchpad variables
C. As new tabs
D. As data pills

Answer: D

NEW QUESTION 272
- (Topic 2)
An IT manager is responsible for the Network and Hardware assignment groups, each group contains 5 team members. These team members are working on
many tasks, but the manager cannot see any tasks on the Service Desk > My Groups Work list. What could explain this?

A. The Service Desk > My Groups Work list shows active work tasks that are not yet assigned.
B. The manager does not have the itil role.
C. The manager is not a member of the Service Desk group.
D. The manager is not a member of the Network and Hardware groups.
E. The Assignment Group manager field is empty.

Answer: C
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Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/users-and-groups/task/t_CreateAGroup.html

NEW QUESTION 275
- (Topic 2)
Which of the following steps can be used to import new data into ServiceNow from a spreadsheet?

A. Select Data Source, Schedule Transform
B. Load Data, Create Transform Map, Run Transform
C. Define Data Source, Select Transform Map, Run Transform
D. Select Import Set, Select Transform Map, Run Transform

Answer: D

NEW QUESTION 279
- (Topic 2)
Which module is used as the first step for importing data?

A. Coalesce Data
B. Transform Data
C. Import Data
D. Load Data

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/paris-platform-administration/page/administer/import-sets/concept/c_ImportDataUsingImportSets.htm

NEW QUESTION 280
- (Topic 1)
When searching using the App Navigator search field, what can be returned? (Choose four.)

A. Names of Applications and Modules
B. Names of Modules
C. Names of Applications
D. Favorites
E. History Records
F. Titles of Dashboard Gauges

Answer: ABCD

NEW QUESTION 282
- (Topic 2)
What import utility do you use when the field names on the import set match the name of the fields on the Target table?

A. Schema Mapping
B. Automatic Mapping
C. Mapping Assist
D. Mapping Dashboard

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/script/server-scripting/concept/c_MappingOptions.html

NEW QUESTION 287
- (Topic 1)
What are the 5 provided Roles by ServiceNow?

A. System Administrator: The admin role provides access to all platform features, applications, functions and data.
B. Specialized Administrator: Specialized administrator roles manage specific functions or applications, such as Assignment Rules, Knowledge base, reports, or
web services
C. Fulfiller: Users with the ITIL role may fulfill ITIL activities associated with the ITIL workflow, including Incident and Change management.
D. Approver: Users with the Approver user role can perform all requester actions and may view or modify approval records directed to the approver
E. Requester: Also known as Employee Self Service (ESS) users, these users have no roles but can submit and manage their own requests, access public pages,
etc.

Answer: ABCDE

NEW QUESTION 290
- (Topic 1)
A User is stored in which table?

A. User [sys_user]
B. User [ sys_user_group]
C. User [ syst_user_profile]
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D. User [user_profile]

Answer: A

NEW QUESTION 294
- (Topic 1)
There are _____ common types of Interfaces (Numeric Value) 6: There are six common types of interfaces

A. Homepage: Consists of navigational elements, functional controls, and platform information.
B. List: Display records from a data table, as well as allow you to edit the record information using the List Editor functionally.
C. Form: Data is entered into ServiceNow through forms
D. Dashboard: Enable you to display multiple performance analytics, reporting and other widgets on a single screen.
E. Maps: Display ServiceNow data graphically on a Google map
F. Timelines: Used to track tasks or projects

Answer: C

NEW QUESTION 298
- (Topic 1)
What are the two pathways to view feedback left on a published article?

A. Knowledge > articles > My Flagged
B. Knowledge base > my knowledge > flagged articles
C. Knowledge > My articles > Flagged
D. Knowledge > articles > published

Answer: AD

NEW QUESTION 301
- (Topic 1)
ServiceNow is a single-instance, multiple tenant architecture?

A. True
B. False

Answer: B

NEW QUESTION 303
- (Topic 1)
What is a way that you can mark a knowledge article for review?

A. Flag article
B. Review
C. Bookmark
D. On Hold

Answer: A

NEW QUESTION 307
- (Topic 1)
What module in the Service Catalog application does an Administrator access to begin creating a new item?

A. Maintain Categories
B. Maintain Items
C. Content Items
D. Items

Answer: B

NEW QUESTION 309
- (Topic 1)
Which one of the following statements is true about Column Context Menus?

A. It displays actions such as creating quick reports, configuring the list, and exporting data
B. It displays actions related to filtering options, assigning tags, and search
C. It displays actions related to viewing and filtering the entire list
D. It displays actions such as view form, view related task, and add relationship

Answer: A

NEW QUESTION 310
- (Topic 1)
Which group of permissions is used to control Application and Module access?

A. Access Control Rules
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B. UI Policies
C. Roles
D. Assignment Rules

Answer: C

NEW QUESTION 312
- (Topic 1)
Business Rules are used to enforce mandatory data on a form.

A. True
B. False

Answer: B

NEW QUESTION 313
- (Topic 1)
What is a characteristic of importing data into ServiceNow?

A. An existing Transform Map can be used one time on the same import set
B. Coalesce fields are used only after running Transform
C. Any user can manage and set up import sets
D. An existing Transform Map can be used multiple times on the same import set

Answer: D

NEW QUESTION 315
- (Topic 1)
What is the path an Administrator could take to view the fulfillment stage task list for an order placed by a user?

A. RITM (Number)>REQ (Number)>PROCUREMENT (Number)
B. REQ (Number)>RITM (Number)>PROCUREMENT (Number)
C. REQ (Number)>RITM (Number)>TASK (Number)
D. FULFILLMENT (Number)>RITM (Number)>TASK (Number)

Answer: C

NEW QUESTION 319
- (Topic 1)
Knowledge articles within a knowledge base are grouped by category.

A. True
B. False

Answer: A

NEW QUESTION 321
- (Topic 1)
Where would you go in ServiceNow to order services and products offered by various departments?

A. Service Catalog
B. Self Service
C. Service Department
D. Customer Service

Answer: A

NEW QUESTION 322
- (Topic 1)
What are the 6 methods available for user authentication?

A. Local Database: The user name and password in their user record in the instance database.
B. Multifactor: The user name and password in the database and passcode sent to the user's mobile device that has Google Authenticator installed
C. LDAP: The user name and password are accessed via LDAP in the corporate directory, which has a matching user account in the database.
D. SAML 2.0: The user name and password configured in a SAML identity provider account, which has a matching user account in the database.
E. OAuth 2.0: The user name and password of OAuth identity provider, which has a matching user account in the database.
F. Digest Token: An encrypted digest of the user name and password in the user record.

Answer: ABCDEF

NEW QUESTION 323
- (Topic 1)
What is the purpose of flagging an article in a knowledge base?

A. To mark an article to read later.
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B. Allow a user to submit feedback about an article
C. Reporting an error

Answer: B

NEW QUESTION 327
- (Topic 1)
What refers to an application or system that accesses a remote service or another computer system, known as a server?

A. Server
B. Client
C. Script
D. Policies

Answer: B

NEW QUESTION 332
- (Topic 1)
Which term refers to application menus and modules which you may want to access quickly and often?

A. Breadcrumb
B. Favorite
C. Tag
D. Bookmark

Answer: B

NEW QUESTION 336
- (Topic 1)
A role is recorded in which table?

A. Role[sys_user]
B. Role[sys_user_profile]
C. Role[sys_user_record]
D. Role[sys_user_role]

Answer: A

NEW QUESTION 338
- (Topic 1)
Which of the following can be customized through the Basic Configuration UI 16 module? (Choose three.)

A. Banner Image
B. Record Number Format
C. Browser Tab Title
D. System Date Format
E. Form Header Size

Answer: ACD

NEW QUESTION 339
- (Topic 1)
Which configuration allows you to use a script to coalesce data in Import Sets?

A. Multiple-field coalesce
B. No coalesce
C. Conditional coalesce
D. Single-field coalesce

Answer: C

NEW QUESTION 341
- (Topic 1)
What is a Dictionary Override?

A. A Dictionary Override is an incoming customer update in an Update Set which applies to the same objects as a newer local customer update
B. A Dictionary Override is the addition, modification, or removal of anything that could have an effect on IT services
C. A Dictionary Override is a task within a workflow that requests an action before the workflow can continue
D. A Dictionary Override sets field properties in extended tables

Answer: D

NEW QUESTION 343
- (Topic 1)
Which one of the following statements describes the contents of the Configuration Management Database (CMDB)?
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A. The CMDB contains data about tangible and intangible business assets
B. The CMDB contains the Business Rules that direct the intangible, configurable assets used by a company
C. The CMDB archives all Service Management PaaS equipment metadata and usage statistics
D. The CMDB contains ITIL process data pertaining to configuration items

Answer: A

NEW QUESTION 347
- (Topic 1)
Each knowledge bases can have unique lifecycle workflows, user criteria, category structures, and management assignments.

A. True
B. False

Answer: A

NEW QUESTION 352
- (Topic 1)
Which term best describes something that is created, has worked performed upon it, and is eventually moved to a state of closed?

A. report
B. workflow
C. event
D. task

Answer: D

NEW QUESTION 355
- (Topic 1)
As it relates to ServiceNow reporting, which of the following statements describes what a metric can do?

A. A metric is a report gauge used on homepages to display real-time data
B. A metric is a time measurement used to report the effectiveness of workflows and SLAs
C. A metric is used to measure and evaluate the effectiveness of IT service management processes
D. A metric is a comparative measurement used to report the effectiveness of workflows and SLAs.

Answer: C

NEW QUESTION 357
- (Topic 1)
Which one of the following modules can be used to view field settings for a table?

A. Tables & Columns
B. Access Control
C. Columns and Fields
D. Tables and Fields

Answer: A

NEW QUESTION 360
- (Topic 1)
What is a formatter? Select one of the following.

A. A formatter allows you to configure applications on your instance
B. A formatter is a form element used to display information that is not a field in the record
C. A formatter allows you to populate fields automatically
D. A formatter is a set of conditions applied to a table to help find and work with data

Answer: B

NEW QUESTION 365
- (Topic 1)
Which technique is used to get information from a series of referenced fields from different tables?

A. Table-Walking
B. Sys_ID Pulling
C. Dot-Walking
D. Record-Hopping

Answer: C

NEW QUESTION 370
- (Topic 1)
Table Access Control rules are processed in the following order:
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A. any table name (wildcard), parent table name, table name
B. table name, parent table name, any table name (wildcard)
C. parent table name, table name, any table name (wildcard)
D. any table name (wildcard), table name, parent table name

Answer: B

NEW QUESTION 373
- (Topic 1)
In what order should filter elements be specified?

A. Field, Operator, then Value
B. Field, Operator, then Condition
C. Operator, Condition, then Value
D. Value, Operator, then Field

Answer: A

NEW QUESTION 374
- (Topic 1)
Record numbers have to be manually incremented

A. True
B. False

Answer: B

NEW QUESTION 377
- (Topic 1)
How are Workflows moved between instances?

A. Workflows are moved using Update Sets
B. Workflows are moved using Transform Maps
C. Workflows are moved using Application Sets
D. Workflows cannot be moved between instances

Answer: A

NEW QUESTION 378
- (Topic 1)
Which one of the following statements is a recommendation from ServiceNow about Update Sets?

A. Avoid using the Default Update set as an Update Set for moving customizations from instance to instance
B. Before moving customizations from instance to instance with Update Sets, ensure that both instances are different versions
C. Use the Baseline Update Set to store the contents of items after they are changed the first time
D. Once an Update Set is closed as “Complete”, change it back to “In Progress” until it is applied to another instance

Answer: A

NEW QUESTION 381
- (Topic 1)
What is the master table that contains a record for each table in the database?

A. [sys_master_db]
B. [sys_db_object]
C. [sys_master_object]
D. [sys_object_db]

Answer: B

NEW QUESTION 382
- (Topic 1)
Where can Admins check which release is running on an ServiceNow instance?

A. Memory Stats module
B. Stats module
C. System.upgraded table
D. Transactions log

Answer: B

NEW QUESTION 385
- (Topic 1)
Which one of the following statements applies to a set of fields when they are coalesced during an import?
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A. If a match is found using the coalesce fields, the existing record is updated with the information being imported
B. If a match is not found using the coalesce fields, the system does not create a Transform Map
C. If a match is found using the coalesce fields, the system creates a new record
D. If a match is not found using the coalesce fields, the existing record is updated with the information being imported

Answer: A

NEW QUESTION 389
- (Topic 1)
A REQ number in the Service Catalog represents…

A. the order number.
B. the stage.
C. the task to complete.
D. the individual item in the order.

Answer: A

NEW QUESTION 392
- (Topic 1)
When using the Load Data and Transform Map process, what is the Mapping Assist used for?

A. Mapping fields using the Import Log
B. Mapping fields using Transform History
C. Mapping fields using an SLA
D. Mapping fields using a Field Map

Answer: D

NEW QUESTION 393
- (Topic 1)
UI Action can prompt that an Incident has been successfully submitted.

A. True
B. False

Answer: A

NEW QUESTION 394
- (Topic 1)
Which type of tables may be extended by other tables, but do not extend another table?

A. Base Tables
B. Core Tables
C. Extended Tables
D. Custom Tables

Answer: A

NEW QUESTION 398
- (Topic 1)
What is the purpose of a Related List?

A. To create a one-to-many relationship
B. To dot-walk to a core table
C. To present related fields
D. To present related records

Answer: D

NEW QUESTION 402
- (Topic 1)
Which one statement correctly describes Access Control rule evaluation?

A. Rules are evaluated using role
B. The role with the most permissions evaluates the rules first
C. If more than one rule applies to a row, the older rule is evaluated first
D. If a row level rule and a field level rule exist, both rules must be true before an operation is allowed
E. Rules are evaluated from the general to the specific, so a table rule must be active to continue

Answer: D

NEW QUESTION 404
- (Topic 1)
Data Policy can enforce mandatory data on import.
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A. True
B. False

Answer: A

NEW QUESTION 406
- (Topic 1)
A Service Catalog may include which of the following components?

A. Order Guides, Exchange Rates, Calendars
B. Order Guides, Catalog Items, and Interceptors
C. Catalog Items, Asset Contracts, Task Surveys
D. Record Producers, Order Guides, and Catalog Items

Answer: D

NEW QUESTION 409
- (Topic 1)
What are the three components of a filter condition?

A. Table
B. Value
C. Field
D. Operator

Answer: BCD

NEW QUESTION 411
- (Topic 3)
A task worker asks how they can monitor any updates occurring to recands assigned to him, like responses from customers, What do you suggest?

A. Open an Agent workspace tab for each record he wants to monitor
B. Select Service Desk > My Work Dashboard
C. Click on the eyeglass icon t
D. expand the Monitor frame
E. On My Work list, select the Activity Stream icon to show a frame with live updates

Answer: D

NEW QUESTION 414
- (Topic 3)
What ServiceNow feature allows you to include data from a secondary related table on a report?

A. SQL
B. Dot Walking
C. Outer Join
D. Joins

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-now-intelligence/page/use/reporting/concept/c_HowToAccessRelatedTables.html

NEW QUESTION 416
- (Topic 3)
What would you do, on a list, if you wanted to show the records in groups, based on the column category? (Choose two.)

A. On list Context Menu, select Group By > Category
B. On the Filter Menu, select Group By > Category
C. Click Group On icon, select Category
D. On Navigator Filter, type tablename.group.category and press enter
E. On the Category column title, click Context menu > Group By Category

Answer: AE

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_GroupedLists.html

NEW QUESTION 417
- (Topic 3)
A Role is defined as what?

A. A collection of permissions
B. A set of user access policies
C. A Persona in a workflow
D. A set of access control rules
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Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/roles/concept/c_Roles.html

NEW QUESTION 419
- (Topic 3)
What contains the configuration changes made in an instance (i.e. changes in a form) and
helps to implement the changes from the Dev environment to another environment?

A. Update sets
B. Transform maps
C. System dictionaries
D. Import sets

Answer: A

Explanation: 
Update sets are the configuration changes made in an instance, such as changes in a form, that can be exported from one instance and imported into another.
This helps to implement the changes from the Dev environment to another environment, such as Test or Prod. Update sets capture the changes made to system
properties, UI actions, business rules, workflows, and other customizations.
References1: Get started with update sets - ServiceNow - Now Support2: Product Documentation | ServiceNow3: Update Set in ServiceNow, Captured, Non-
Captured, Commit, Import …4: In depth Concepts Update Set in ServiceNow - Basico ServiceNow Learning5: Retrieving and committing update sets between
different … - ServiceNow

NEW QUESTION 422
- (Topic 3)
What feature allows, you to limit who is able to contribute or read knowledge within a knowledge base?

A. Categories
B. Roles
C. User Criteria
D. Groups

Answer: C

NEW QUESTION 424
- (Topic 3)
What setting allows users to view a Knowledge Base article even if the are not logged in?

A. The View All setting
B. The Allow role
C. The ESS role
D. The Public setting

Answer: C

NEW QUESTION 429
- (Topic 3)
Which helps to visualize configuration items and their relationships?

A. Transform Map
B. Schema Map
C. Tables
D. Flow Design
E. Dependency View

Answer: E

Explanation: 
The Dependency View provides a visual representation of the relationships between configuration items (CIs) in ServiceNow. It allows you to see how CIs are
connected and how changes to one CI may impact others.
References:
? ServiceNow Product Documentation: Configuration item relationships in the CMDB
- https://docs.servicenow.com/bundle/vancouver-servicenow- platform/page/product/configuration-management/concept/c_CIRelationships.html
? ServiceNow Community: How to display dependencies for CIs in the Dependency
View - https://www.servicenow.com/community/service-management-forum/load- a-specific-dependency-view-map/m-p/410421

NEW QUESTION 434
- (Topic 3)
What are examples of UI Actions relating to forms?
Choose 3 answers

A. Form Context Menu
B. Form View
C. Form Buttons
D. Form Links.
E. Form Columns
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Answer: ACD

NEW QUESTION 436
- (Topic 3)
While on an Incident record, how would you add a Tag for "Special Handling" to the record?

A. Click on the More options (.,.) icon, click Add Tag, type Special Handling, press enter
B. On the Special Handling field, check the box
C. On the Tag field, select Special Handling from the choice list
D. Click on the Context menu, select Add Tag, type Special Handling, press enter

Answer: A

NEW QUESTION 439
- (Topic 3)
What are the three key tables in an enterprise CMDB? (Choose three.)

A. cmdb
B. sn_cmdb_bak
C. cmdb_rel_ci
D. sn_cmdb
E. cmdb_bak
F. cmdb_ci
G. sn_cmdb_ci

Answer: ACF

Explanation: 
Reference: https://community.servicenow.com/community?id=community_question&sys_id=7ab22ad5 dbf20498d82ffb2439961938

NEW QUESTION 440
- (Topic 3)
What do you click when you have made modification to your report, and your want to see the results without saving?

A. Execute
B. Try ir
C. Run
D. Test
E. Preview

Answer: D

NEW QUESTION 441
- (Topic 3)
Which tables are available by default in a ServiceNow instance? Choose 3 answers

A. User
B. Incident
C. Item
D. Issue
E. Project
F. Task

Answer: ABF

Explanation: 
These tables are available by default in a ServiceNow instance because they are part of the core platform and are used to store essential data for users, incidents,
and tasks. The other tables are not available by default, but can be created or activated by installing plugins or applications.
References1: Tables & Dictionary - Frequently asked Questions (FAQ) - ServiceNow2: ServiceNow – The List of All Tables (sys_db_object)3: How To Set A
Default Field Value in ServiceNow? - The Snowball

NEW QUESTION 444
- (Topic 3)
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An order from the Service Catalog has been placed. Two records in the Platform are
created as a result. Which two records are associated with tins newly ordered item? Choose 2 answers

A. A record of sc_task
B. A record of sc_req_llem table
C. A change record
D. An Incident record
E. A problem record

Answer: AB

NEW QUESTION 445
- (Topic 3)
What module enables an administrator to define destinations for imported data on any ServiceNow table?

A. Field Transform
B. Transform Map
C. Schema Map
D. Import Map

Answer: B

NEW QUESTION 449
- (Topic 3)
What does ServiceNow recommend as a best practice regarding data imports?

A. Adjust your Transform maps, after the data is loaded into the target table.
B. Use extremely large Import Sets, instead of multiple large Import Sets.
C. Create a new Import set table for each new data load.
D. Plan time before your import to remove obsolete or inaccurate data.
E. Monitor data quality and clean imported data, using the Data Scrub Workspace.

Answer: D

Explanation: 
 This is a best practice because it reduces the amount of data that needs to be imported, transformed, and stored in ServiceNow, and improves the data quality
and performance of the system1.
ReferencesImport and export resources page

NEW QUESTION 452
- (Topic 3)
What access does a user need to be able to import anicies to a knowledge base?

A. Can contribute
B. sn_knowledge_contripute
C. sn_knowledge_import
D. Can import

Answer: A

NEW QUESTION 456
- (Topic 3)
As administrator, what must you do to access feature of High Security Settings?

A. Select Elevate Roles
B. Add security_admin role to your user account
C. Impersonate Security Admin
D. Use System Administrator < Elevate Roles module

Answer: A

NEW QUESTION 461
- (Topic 3)
One related list, which buttons are commonly used for managing the records on the list? Choose 3 answers

A. Publish
B. New
C. Ada
D. Manage
E. Edit

Answer: BCE

NEW QUESTION 463
- (Topic 3)
What icon do you use to change the boon and color on a Favorite?
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A. Pencil
B. Star
C. Clack
D. Tringle

Answer: A

NEW QUESTION 466
- (Topic 3)
What are the steps for applying an update set to an instance?

A. Retrieve, Preview, Commit
B. Specify, Transform, Apply
C. Retrieve, Assess, Apply
D. Get, Test, Push
E. Pull, Review, Push

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-sets/hier-update-sets/concept/us-hier- overview.html#us-
hier-overview

NEW QUESTION 470
- (Topic 3)
When would you use the following steps?
* 1, Homepage Admin > Pages
* 2. Right click on Homepage record
* 3. Select Unioad Portal Page

A. To publish a Homepage to the Portal
B. To retire a Homepage
C. To delete a Homepage
D. o To add a Homepage to an update set

Answer: D

NEW QUESTION 474
- (Topic 3)
How would you navigate to the Schema map for a table?

A. System Dictionary > Show Schema Map; Select Table
B. System Definition > Tables; Select Table; Go to Related links and click Show Schema Map
C. System Definition > Show Schema Map; Select Table
D. System Definition > Dictionary: Select Table; Go to Related links and click Show Schema Map

Answer: B

NEW QUESTION 478
- (Topic 3)
An IT user calls the service desk because his work needs to be completed on ask records. All he can see a Self Service on his homepage when he logs in to the
ServiceNow instance. What issue could explain this?
Choose 2 answers

A. His user account failed LDAP authentication
B. His user account does not Belong to any groups, which contain the ITIL role
C. His user account was not approved by his manager
D. His user account does not have ITIL role
E. His user account Is not logged in properly

Answer: BE

NEW QUESTION 483
- (Topic 3)
Which system property is added and set to true in order to see impersonation events in the System Log?

A. glide user_setting
B. glide sys all_jmpersonation
C. glide sys log_jmpersonabon
D. glide.impersonation_setting
E. glide sys admin_login

Answer: C

Explanation: 
 The system property glide.sys.log_impersonation is added and set to true in order to see impersonation events in the System Log2. This property enables logging
of
impersonation events in the Event [sysevent] table, which can be accessed by navigating to System Logs > Events2.
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References
? How to find the history of impersonations - Support and Troubleshooting - ServiceNow

NEW QUESTION 484
- (Topic 3)
What resource can you use to view details of the tables and configuration items (CIs) associated with a particular use case?

A. Scenario Dashboard
B. CI Use Case Modeler
C. CMDB Use Case Modeler
D. Common Service Data Model (CSDM) product view

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/quebec-servicenow-platform/page/product/csdm-implementation/reference/cmdb-use-case.html

NEW QUESTION 489
- (Topic 3)
Which allows the creation of a task-based record from Service Catalog?

A. Record Producers
B. UI Builder
C. Assignment Rule
D. Flow Designer
E. UI Actions=

Answer: D

NEW QUESTION 494
- (Topic 3)
The Report Designer contains different sections for configuring your report. Which section is used to adjust the look of your report, including colors, files, and
legend layout?

A. Format
B. Layout
C. Style
D. Configure

Answer: C

NEW QUESTION 495
- (Topic 3)
On a filter condition, there is an element, which is based on the table, the user access rights, and columns on the table. What is this element called?

A. Attribute
B. Label
C. Field
D. Column
E. Data Element

Answer: C

NEW QUESTION 496
- (Topic 3)
On a list, what does each row show?

A. A filter
B. A record
C. A table
D. A field

Answer: B

Explanation: 
 A list is a collection of records from a table. Each row in a list represents a record in that table1.
ReferencesIdentifying the view used on a list or formServiceNow: List Views for BeginnersHow Do I See A List Of Users And Their Roles In ServiceNow

NEW QUESTION 500
- (Topic 3)
Which module would you use to customize your instances banner image, text and colors?
A Homepage Admin > Pages > Branding

A. System Ul > Ul Pages > Branding
B. System Properties > Branding
C. System Properties > Basic Configuration UI16
D. Service Portal > Portals > Branding
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Answer: D

NEW QUESTION 502
......
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